Esri Maps for Dynamics CRM
## Table of Contents

### Design a map chart
- Sign in to ArcGIS Online ........................................................................................................... 3
- Create a map chart ........................................................................................................................... 4
- Add data from ArcGIS ....................................................................................................................... 5
- Location types .................................................................................................................................. 6
- Add a location type ............................................................................................................................. 8
- Perform an advanced search .............................................................................................................. 9
- Feature display and style .................................................................................................................... 12
- Change a layer's style ........................................................................................................................ 13
- Customize the map contents ............................................................................................................. 14
- Remove a layer .................................................................................................................................. 16
- Configure and display pop-up windows .......................................................................................... 17
- Change layer display ......................................................................................................................... 18
- Change the basemap .......................................................................................................................... 19

### Use the map chart
- Access map charts ............................................................................................................................ 20
- Navigate the map ............................................................................................................................... 21
- Zoom to the full extent of a layer ....................................................................................................... 22
- View layer details ............................................................................................................................. 23
- View layer attributes ........................................................................................................................ 24
- Select features on the map ................................................................................................................. 25
- Zoom to a feature ............................................................................................................................... 27
- Delete a map chart ............................................................................................................................ 28
- Use Esri Maps in a dashboard ......................................................................................................... 29
- Share a map on ArcGIS .................................................................................................................... 30

### Perform analysis
- Configure clustering ......................................................................................................................... 31
- About finding a route ......................................................................................................................... 33
- Find a driving route ........................................................................................................................... 35
- Infographics ....................................................................................................................................... 36
- Add a heat map ................................................................................................................................... 39
- Create reports .................................................................................................................................... 41

### Reference
- Frequently asked questions ............................................................................................................... 43
- Essential vocabulary .......................................................................................................................... 44
- Copyright information ...................................................................................................................... 46

### Design a map chart
Sign in to ArcGIS Online

ArcGIS is Esri's cloud-based, collaborative content management system which allows organizations to manage their geographic information in a secure and configurable environment. If you are an ArcGIS Online organization administrator, you can invite users by creating logins for members or allowing the members to create their own logins. If you are a member of an ArcGIS Online organization, your organization's administrator has granted you either user or publisher permissions for ArcGIS Online. With user permissions you can add items, create web maps, and participate in groups. With publisher permissions you have privileges to publish hosted feature services. This is the required role for sharing layers and maps from Esri Maps for Dynamics CRM to ArcGIS Online. If you are unsure as to your role, contact your organization's administrator or view your profile page. The profile page lists your role in the organization.

Note: If you need technical support for Esri Maps for Dynamics CRM, contact your organization's administrator to log a support incident with Esri.

Esri Maps for Dynamics CRM works directly with your organization's ArcGIS Online subscription and allows you to access geographic content published by both Esri and the community. It then combines that content with your Microsoft Dynamics CRM data to enhance the visual experience of your map. For example, you may have Microsoft Dynamics CRM data for retail store locations. You can add household income data from ArcGIS Online for the areas around those stores in order to better understand whether a store is under or over performing. Once you create the desired maps and layers in Esri Maps for Dynamics CRM, you can publish them to ArcGIS Online for sharing with others.

To get started using Esri Maps for Dynamics CRM, sign in to ArcGIS Online using the login information provided to you by your organization's administrator.

1. Click Esri Maps in the navigation pane.
2. Click Settings.
3. Enter your ArcGIS Online user name and password in the dialog box that appears and click Sign in. You are now signed in to ArcGIS Online.
Create a map chart

A map chart provides a geographic view of your CRM data and allows you to explore and interact with that data on a map. With Esri Maps for Dynamics CRM, data stored in Microsoft Dynamics CRM can be displayed on a map chart alongside data from the ArcGIS platform, allowing for analysis of relationships and sharing those findings with others. Each time data are added to the map chart, whether from Microsoft Dynamics CRM or from ArcGIS Online, Esri Maps for Dynamics CRM creates a layer to visually represent that information. A layer in a map chart can represent any geographic feature, such as a road, river, building, or park, and is similar to what you might see in the legend of a paper map. For example, if you add Microsoft Dynamics CRM data containing account locations, Esri Maps for Dynamics CRM creates a layer containing the account information, adds it to the map chart, and displays it in the Contents pane. In the Contents pane, all layers in the map chart are listed (similar to a legend of a paper map) and you can remove the layer, style (symbolize) the layer, and so on.

To bring these capabilities into Esri Maps for Dynamics CRM, see the following steps to create a map chart:

1. Open Microsoft Dynamics CRM and sign in to ArcGIS.
2. Click Esri Maps and then click Map Gallery.
3. Click Create new map in the Map Gallery. A new map will appear.
4. Add data layers to the map in the following ways:
   • from Dynamics CRM. Select the type of record you want to map. Commonly mapped record types are Accounts, Contacts, Leads, Opportunities, and Competitors. A recommended best practice is to spatially enable these record types before they are used on a map.
   • from ArcGIS. Click Add data and select from ArcGIS. By default, ArcGIS will be searched. To find maps and layers within your organization, enter a search term and click My Organization. Click Add next to the map or layer you want to add to your map.

5. To finish the design process and make your new map chart available for use, click Save. Select a record type, enter a chart name and description, and click OK.

Note: The record type you select determines where the map chart will be visible. For example, if the Lead record type is selected, the map chart will be available by clicking on Leads in the navigation pane, expanding the "Click here to view the chart" pane, and selecting the map chart from the drop-down menu.
Add data from ArcGIS

Esri Maps for Dynamics CRM works directly with your organization's ArcGIS subscription, allowing you to search for content within your organization and, if enabled by your administrator, search for public content published by the GIS community, including Esri, and local governments and agencies around the world. Adding data from ArcGIS is a quick and easy way to add content to your map to complement your existing Microsoft Dynamics CRM data. For example, you may have Microsoft Dynamics CRM data showing proposed store locations and want to add household income census data from ArcGIS for those areas to visually analyze trends.

With Esri Maps for Dynamics CRM, you can search for map services, feature services, and web maps on ArcGIS to add to your map. Once added, they become layers in your map.

Steps:

1. Sign in to ArcGIS if you are not already signed in.
2. From the Add data menu, select from ArcGIS.
3. Search for a layer to add to the map in any of the following ways:
   • Enter one or more keywords and the Search icon to search all of ArcGIS Online. If desired, you can My organization to narrow your results.
   • one of the popular search categories to browse available maps and services from Esri within that category.
   • Enter one or more keywords and a category to search within that category.

   **Note:** The Show available data in drop-down menu allows you to show available data for the United States, Canada, and Global regions. The option selected by default is the region of the user who is currently logged in. You can select another option from the menu to filter results for both full content and category searches. If you change the region, a new search is performed and the results are displayed immediately.

   • Use advanced keyword searches to narrow your results by specifying how you want to search for an item.

4. Check the Zoom to data check box if you want the map to zoom to the full extent of the data you add.
5. Find the service you want and Add.

   **Note:** Depending on the data you add, you may consume ArcGIS service credits. To help you estimate how many service credits you will use, a layer containing the data is added to the map and is listed in the Contents pane.

   **Note:** If you want more information about the data, you can the Details link.
Location types

You can easily add data from Microsoft Dynamics CRM directly to a map. When adding data from Microsoft Dynamics CRM, select the location type that best represents your information.

Default location types

Esri Maps for Dynamics CRM provides the following default location types:

- **Address**—Depending on the geographic region of your organization, address data can be comprised of any of the following: address, neighborhood, city, subregion, region, state, province, postal code, United States Zip Code, country, and so on. The more address elements your data contains, the more accurate your results will be. The address elements can be in separate fields or they can be contained in one field (single-line address). Both methods of finding addresses are supported, but the best results are obtained by using all address elements and storing them in separate fields.

- **Latitude, Longitude**—Latitude and Longitude values represent an X, Y coordinate location on the map. You can add X, Y coordinate data if it's in either the World Geodetic Survey 1984 (WGS84) or the Web Mercator coordinate system. If your latitude (Y) values fall between -90 and 90 and the longitude (X) values range from -180 to 180, use WGS84. If your latitude and longitude values are in meters and have 6, 7, or 8 digits before (to the left of) the decimal point, use Web Mercator.

- **Standard administrative boundaries**—Standard administrative boundaries include cities, states, provinces, United States Zip Codes, postal codes, and countries. The administrative boundaries available to you when adding data are determined by your geographic location. Cities are added to the map as points. States, provinces, postal codes, United States Zip Codes, and countries are added to the map as polygons, which represent both the shape and the location of the place. When entering countries, you can use the Geonames Country Codes as a reference for accepted spelling variations.

Choose a location type

When choosing a location type, it is important to make sure that there is a one-to-one relationship between the rows of data in the dataset and the features in the map layer that is being used to display the data. For example, suppose you want to show revenue by state in a map of the United States. If your dataset has a single row of data for each state, you should use the US States location type.

However, if your dataset has multiple rows of data for each state (one row for each Zip Code area, for example) and you use the US States location type, the map may not correctly represent the state revenue values in your data. In this case, you should use a more appropriate location type, such as US ZIP Code, that would have a one-to-one relationship between rows and features.
Specify a location type

If none of the default location types represent your data, you can specify a map service or feature service from ArcGIS to use as a location type. For example, if your organization has its own boundaries (water districts, sales districts, or zoning boundaries), you can map your data using those locations instead of the default location types as long as there is a one-to-one relationship between the rows in your business data and the features in the service. Esri Maps for Dynamics CRM supports feature services and map services.

A note about custom location types

Custom location types are not available when creating workflows within the Workflow Gallery.
Add a location type

You can use a map service or feature service from ArcGIS to specify a location type. For example, if your organization has its own boundaries (water districts, sales districts, or zoning boundaries), you can map your data using those locations instead of the default location types.

**Note:** When adding a map service or feature service as a location type, ensure that there is a one-to-one relationship between the rows in your Microsoft Dynamics CRM data and the features in the service you choose.

**Steps:**

1. Once you have selected the data, click **Add location type**.
2. In the search box, type one or more keywords and press **Enter** to search for the service you want to use as a location type. You can click **My organization** to narrow your results.
   
   **Note:** You can use advanced keyword searches to narrow your results by specifying how you want to search for an item.
3. Find the service you want and click **Select**.
4. Click the layer you want to use to look up locations and click **Next**.
5. Select the columns containing the attributes you want to use for looking up locations. Click **Next**.
6. In the **Name** box, type a name for your custom location type. Optionally, type a description in the **Description** box.
7. Click **Add**.
   
   Your location type is added to the list of locations.
   
   **Note:** If you made a mistake when adding your location type, you can delete it by selecting it in the list and clicking **Delete location type**.
8. Click your new location type in the list and click **Next**.
9. Select the columns containing the location information and click **Next**.
10. Select the format of the column data you are adding. If you want a different name for the layer, type a new name in the **Layer name** box.
11. Click **Add data to map**.
   
   A layer containing the data is added to the map and is listed in the **Contents** pane.
Perform an advanced search

When adding data from ArcGIS, you use search keywords to find data on ArcGIS. You can use advanced search techniques such as item and group field searches, range searches, Boolean operators, and grouping to make your searches more efficient by filtering out unwanted results.

Narrowing your search results

You can use advanced keyword searches to narrow your results by specifying how you want to search for an item. Below are descriptions for the different ways you can do this.

Fields

When performing a search for content or groups, you can either specify a field or use the default fields. For items, the default fields are title, tags, snippet, description, accessinformation, spatialreference, type, and typekeywords. For groups, the default fields are id, title, description, snippet, tags, and owner. The best match is always returned. See the tables below for descriptions of these fields.

You can search a specific field by typing the field name followed by a colon and the term you are looking for (for a term with multiple words, use double quotes, such as "washoe county"). If you do not use a field indicator, the default fields are searched.

Item fields

You can refine your item searches by using specific fields in your search string. These fields include the following:

<table>
<thead>
<tr>
<th>Field</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>id</td>
<td>ID of the item; for example, id:4e770315ad9049e7950b552aa1e40869 returns the item for that ID.</td>
</tr>
<tr>
<td>owner</td>
<td>Owner of the item; for example, owner:esri returns all content published by Esri. Field and value are case sensitive.</td>
</tr>
<tr>
<td>uploaded</td>
<td>Uploaded is the date uploaded; for example, uploaded: [000001249084800000 TO 000000124954800000] finds all items published between August 1, 2009, 12:00 a.m., to August 6, 2009, 8:40 a.m.</td>
</tr>
<tr>
<td>title</td>
<td>Item title; for example, title:&quot;Southern California&quot; returns items with Southern California in the title.</td>
</tr>
<tr>
<td>type</td>
<td>Type returns the type of item and is a predefined field. For a list of supported item types, see For example, type:map returns items with map as the type, such as map documents and map services.</td>
</tr>
<tr>
<td>description</td>
<td>Item description; for example, description:California finds all items with the term California in the description.</td>
</tr>
<tr>
<td>tags</td>
<td>The tag field; for example, tags:&quot;San Francisco&quot; returns items tagged with the term San Francisco.</td>
</tr>
<tr>
<td>snippet</td>
<td>Summary; for example, snippet:&quot;natural resources&quot; returns items with natural resources in the summary.</td>
</tr>
<tr>
<td>spatialreference</td>
<td>The spatial reference; for example, spatialreference:102100 returns items in the Web Mercator auxiliary sphere projection.</td>
</tr>
<tr>
<td>access</td>
<td>The access field; for example, access:public returns public items. This field is predefined, and the options are public, private, or shared. You will only see private or shared items that you have access to.</td>
</tr>
<tr>
<td>group</td>
<td>The ID of the group; for example, group:1652a410f59c4d8f98fb87b25e0a2669 returns items within the given group.</td>
</tr>
<tr>
<td>numratings</td>
<td>Number of ratings; for example, numratings:6 returns items with six ratings.</td>
</tr>
<tr>
<td>numcomments</td>
<td>Number of comments; for example, numcomments:[1 TO 3] returns items that have one to three comments.</td>
</tr>
<tr>
<td>avgrating</td>
<td>Average rating; for example, avgrating:3.5 returns items with 3.5 as the average rating.</td>
</tr>
</tbody>
</table>
Group fields

You can filter your searches on groups by using specific fields in your search string. Only public groups or groups that you have access to will be searched. These fields include the following:

<table>
<thead>
<tr>
<th>Group field</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>id</td>
<td>Group ID; for example, id:1db70a32f5f8ea9a88f5f460f22557b returns the group for that ID.</td>
</tr>
<tr>
<td>title</td>
<td>Group title; for example, title:redlands returns groups with Redlands in the title.</td>
</tr>
<tr>
<td>owner</td>
<td>Group owner; for example, owner:esri returns groups owned by Esri.</td>
</tr>
<tr>
<td>description</td>
<td>Description; for example, description:&quot;street maps&quot; returns groups with street maps in the description field.</td>
</tr>
<tr>
<td>snippet</td>
<td>Summary; for example, snippet:transportation returns groups with transportation in the group summary.</td>
</tr>
<tr>
<td>tags</td>
<td>The tags field; for example, tags:&quot;bike lanes&quot; returns groups tagged with the term bike lanes.</td>
</tr>
<tr>
<td>phone</td>
<td>Contact information; for example, phone:<a href="mailto:jsmith33@esri.com">jsmith33@esri.com</a> returns groups with <a href="mailto:jsmith33@esri.com">jsmith33@esri.com</a> as the contact.</td>
</tr>
<tr>
<td>created</td>
<td>Created is the date created; for example, created:0000001247085176000 returns groups created on July 8, 2009.</td>
</tr>
<tr>
<td>access</td>
<td>The access level of the group. Values are private and public. Private is the default; for example, access:private returns private groups.</td>
</tr>
<tr>
<td>isinvitationonly</td>
<td>The isinvitationonly field returns groups that require an invitation to join. For example, isinvitationonly:false returns groups that do not require an invitation to join. This field is predefined with the options true or false.</td>
</tr>
</tbody>
</table>

Range searches

Range searches allow you to match on field values between the lower and upper bounds. Range queries can be inclusive or exclusive of the upper and lower bounds. Inclusive range queries are denoted by square brackets. Exclusive range queries are denoted by curly brackets.

For example, if you wanted to find all items uploaded between December 1, 2009, and December 9, 2009, use uploaded:[000001259692864000 TO 000001260384065000].

The uploaded field contains the date and time an item is uploaded in UNIX time. UNIX time is defined as the number of seconds that have elapsed since midnight January 1, 1970. The website stores time in milliseconds, so you need to add three zeros to the end of the UNIX time. Additionally, you need to pad six zeros on the front of the number. This is because the number is stored as a string in the database.

Range searches are not reserved for date fields. You could also use range queries with nondate fields, for example, owner:[arcgis_explorer TO esri]. This will find all items from the owners between arcgis_explorer and esri, including arcgis_explorer and esri.

Boosting a term

Boosting allows you to control the relevance of an item by boosting its term. To boost a term, use the caret symbol (^) with a boost factor (a number) at the end of the term you are searching. The higher the boost factor, the more relevant the term will be. For example, if you are searching for "recent fires" and want "fires" to be more relevant, create the expression recent fires^5.

Boolean operators

Boolean operators allow terms to be combined through logic operators. The website supports AND, plus sign (+), OR, NOT, and minus sign (-) as Boolean operators. Boolean operators must be ALL CAPS.

<table>
<thead>
<tr>
<th>Boolean operator</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>AND</td>
<td>The AND operator is the default conjunction. This means that if there is no Boolean operator between two terms, the AND operator is used. The AND operator performs matching where both terms exist in either the given field or the default fields. This is equivalent to an intersection using sets.</td>
</tr>
<tr>
<td>OR</td>
<td>The OR operator links two terms and finds a match if either of the terms exists. This is equivalent to a union using sets. To search for an item that contains either the term &quot;recent fires&quot; or just &quot;fires,&quot; use the query &quot;recent fires&quot; OR fires.</td>
</tr>
<tr>
<td>+</td>
<td>The plus sign, or the required operator, requires that the term after the symbol exist somewhere in the given field or the default fields. To search for items that must contain &quot;fires&quot; and may contain &quot;recent,&quot; use the query recent +fires.</td>
</tr>
</tbody>
</table>
The NOT operator excludes items that contain the term after NOT. This is equivalent to a difference using sets. To search for documents that contain "California" but not "imagery," use the query California NOT Imagery. The NOT operator cannot be used with just one term.

The minus sign, or the prohibit operator, excludes items that contain the term after the symbol. To search for documents that contain "California" but not "imagery," use the query California -Imagery.

### Grouping

You can create subqueries using parentheses to group clauses. This can be very useful if you want to control the Boolean logic for a query.

To search for either "California" or "recent" and "fires," create the expression (California OR recent) AND fires.

### Field grouping

You can group multiple clauses to a single field using parentheses.

To search for a title that contains both the phrase "population change" and the word "recent," use the query title:("population change" +recent).
Feature display and style

With Esri Maps for Dynamics CRM, you can style your data on the map using different symbols, colors, and sizes to appropriately represent the features. For example, you may want to use different public safety symbols to denote locations of police and fire stations, or use different colors or sizes of a symbol to show locations of major cities according to the population.

When you add Microsoft Dynamics CRM data to the map, Esri Maps for Dynamics CRM creates a layer that appears on the Contents pane and draws the data on the map using a default style. The style can be changed using the options on the Style pane. The Style pane allows you to draw a layer as follows:

- Use a single symbol—Draw the features in a layer containing points using the same symbol.
- Use different colors—Divide your data into groups and show each with a different color.
- Use different-sized symbols—Divide your data into groups and show each with a different size.

For layers containing point features, there are two different types of symbols you can use to style your data: icons and shapes.

- **Icons**—Standard, Business and Facilities, Public Safety, Transportation, People and Places, Public Safety and Health, and Outdoor Recreation.
- **Shapes**—Circles, Crosses, Diamonds, Squares, and Xs.

For layers containing polygon features, you can style your data using different colors.

If you add data from ArcGIS that contains line features, you can change the style of the line features by choosing from different line types and colors and changing the line thickness.

Grouping methods

If you decide to style a layer using either different colors or different-sized symbols (for point features only), you will be asked how you want to group your data and what field (or attribute) to use to group it. If you choose to group your data by categories, your data will be grouped and styled based on a common value for the field (or attribute) you chose for grouping (for example, business types such as retail or wholesale).

If your layer has numeric fields, you can choose to group your data by number ranges. For this grouping option, you must choose a classification method. Each classification method takes your data and divides it into classes (groups). Classification method options include Equal Interval, Natural Breaks, and Quantile. The value at which a feature is placed into a different class is often referred to as a class break. The way in which class breaks are determined by each grouping method is discussed below.

**Equal Interval**

With the Equal Interval classification method, the range of all of your data values are divided into equal-sized subranges. With Equal Interval classification, you specify the number of intervals (or subranges), and Esri Maps for Dynamics CRM automatically determines how to divide the data. For example, if you specify three classes for a field whose values range from 0 to 300, Esri Maps for Dynamics CRM creates three classes with ranges of 0–100, 101–200, and 201–300. Equal Interval is best applied to familiar data ranges, such as percentages and temperature. This method emphasizes the amount of an attribute value relative to other values. For example, it shows that a store is part of the group of stores that make up the top one-third of all sales.

**Natural Breaks**

Natural Breaks classes are based on natural groupings inherent in the data. Class breaks that best group similar values and that maximize the differences between classes are identified. The features are divided into classes whose boundaries are set where there are relatively big differences in the data values. Natural Breaks classification is good for mapping data values that are not evenly distributed as it places clustered values in the same class.

**Quantile**

In Quantile classification, each class contains an equal number of features (for example, 10 per class or 20 per class). A quantile classification is well suited to linearly distributed data. It is useful when you want to emphasize the relative position of a feature among other features—for example, to show that a store is in the top quarter of all stores by sales. Quantile classification assigns the same number of data values to each class. There are no empty classes or classes with too few or too many values. Because features are grouped in equal numbers in each class using quantile classification, the resulting map can often be misleading. Similar features can be placed in adjacent classes, or features with widely different values can be put in the same class. You can minimize this distortion by increasing the number of classes.
Change a layer's style

In Esri Maps for Dynamics CRM, layers are drawn on the map using a default style. You can change a layer's style to any of the styles shown in the Style pane. You cannot add custom styles. The style currently applied to a layer is shown in the Contents pane when you expand the layer by clicking the plus (+) sign.

Steps:

1. Click the Show map contents icon to display the Contents pane.
2. On the Contents pane, click the arrow to the right of the layer whose style you want to change.
3. Click Style.
4. Choose the desired style options.
   The map automatically updates to reflect the style changes you made.

5. Click OK.

Note: You can quickly change the basic style of an individual layer directly from the Contents pane. Click the plus (+) sign to expand the layer contents, and click on the symbol you want to modify. Depending on the layer type, different options are available. For lines and polygons, choose a new color for the shape. For point features, select a different icon from the drop-down menu, or, if the layer was styled using shapes, choose a new color.
Customize the map contents

Show and hide the Contents pane

When you add data to your map, the data appears as one or more layers listed on the Contents pane. When you want to work with the layers in your map—for example, toggle layer visibility, style your data, configure clustering, and so on—you can display the Contents pane and access your layers of data. You can hide the Contents pane at any time when you want a full view of the map.

Steps:
1. To show the Contents pane, click the Show map contents icon.
2. To hide the Contents pane, click the Hide map contents icon.

Depending on the size of the map, the Contents pane and controls may be displayed slightly differently. Maps smaller than 450 pixels wide typically display a compact pane, as shown below.

Toggle a layer’s visibility

The Contents pane lists all layers available to display in the map. By default, Esri Maps for Dynamics CRM displays all available layers. Using the check box beside each layer name, you can specify which layers to display and which ones to hide from view, making it easier for you to work with features on the map. If you have styled a layer by group, you can also hide individual groups as desired.

Steps:
1. Click the Show map contents icon to display the Contents pane.
2. On the Contents pane, do one of the following to define a layer’s visibility:
   • To show the layer on the map, check the check box beside the layer name. By default, all available layers are visible (selected).
   • To hide the layer from the map, uncheck the check box. Items on the specified layer are no longer displayed on the map.
3. You can also toggle the visibility of individual groups:
   a. Click the plus sign (+) beside the layer name to expand the layer contents.
The Contents pane displays the styling applied to the selected layer. If the features in the layer are styled by group, the Contents pane shows the styling of all the groups.

b. Click in the center of the row for the group you want to hide. Text identifying the group turns light gray, and the specified group is hidden in the map.

c. Click on the group again to restore its visibility.

Rename a layer

Layers that you add to the map can be renamed on the Contents pane. When you first add a layer, the layer name is determined by the layer's data source. When you change the layer name on the Contents pane, only the display name of the layer is changed; the name in the underlying data is not affected.

Steps:
1. Click the Show map contents icon to display the Contents pane.
2. Double-click the layer name to highlight it. Alternatively, click the Rename layer icon at the bottom of the Contents pane.
3. While the layer name is highlighted, type the new layer name.
4. Press Enter or click outside the text area to finish.

Change the order of layers

The order in which layers are listed in the Contents pane represents how layers are drawn on the map. Within the map, the layers listed at the top draw over those listed below them, and so on, down the list. You can easily move layers in the Contents pane to adjust their drawing order.

Note: The order of heat map layers and map service layers added from ArcGIS cannot be changed.

Steps:
1. Click the Show map contents icon to display the Contents pane.
2. Click the desired layer in the Contents pane to highlight it.
3. Use the Move layer down and Move layer up icons at the bottom of the Contents pane to move the selected layer to the desired order.
Remove a layer

Any layer that you add to the map can be removed.

Steps:
1. Click the Show map contents icon to display the Contents pane.
2. On the Contents pane, select the layer you want to remove.
3. Click the Remove layer icon at the bottom of the Contents pane.
4. When a confirmation message appears, click Yes.
   
   The layer is removed from the map and is no longer listed in the Contents pane.
Configure and display pop-up windows

Pop-up windows contain descriptive information about the features in each layer in the map. A pop-up window displays a header (title) and attribute information based on the columns and rows in your data. Pop-up windows display when you a feature on the map. You can change the way information is presented in the pop-up window by changing the header and specifying the fields to display.

Some layers from ArcGIS do not support configuring pop-ups. In these instances, the pop-up option will not be available on the layer’s context menu.

Steps:
1. the Show map contents icon to display the Contents pane.
2. On the Contents pane, the arrow to the right of the layer for which you want to configure pop-up windows.
3. the On/Off selector next to Pop-ups to turn on pop-up display.
   The Configure pop-ups icon appears next to the On/Off selector.
4. the Configure pop-ups icon.
5. From the Header menu, select the field you want to display as the header (title) of the pop-up window.
6. Below the Header menu, each field in your data is listed. Check or uncheck the check box next to each field to specify the information that you want to display in the pop-up window.
7. OK when finished.
   When you a feature on the map, the newly configured pop-up window displays. the Zoom to icon on the pop-up window to zoom to the selected feature.
   You can the Infographics icon at the bottom-right of the pop-up window to see graphical information about the areas around your feature. Infographics are visualizations that provide rich contextual information about the areas surrounding the features in your map.
Change layer display

Set the visible range of a layer

As you configure or view your map, you may find it appropriate to limit the levels at which layers display. These levels, or thresholds, allow you to specify that, for example, certain layers should only display when you zoom to the level of a neighborhood or city, or that a layer only displays when you zoom to the level of an entire region or country.

Setting the visible range of a layer can be particularly useful for ensuring that only the relevant data is displayed when zooming in and out to different levels on the map. For example, you may have a layer showing the locations of parks throughout a city. It would be appropriate to display the layer at a city level, but not at a continent level. In this scenario, you would set the city level to be the maximum threshold at which the layer displays. As you zoom out past the city level, the parks layer no longer displays. Alternatively, your map may have state boundaries that only need to be shown at the country level, but not when you have zoomed in closer to the city or neighborhood levels. In this scenario, you would set the minimum threshold of the state boundaries layer to country so that as soon as you zoom in past that level, the layer no longer displays. In other words, with a minimum threshold of country, the state boundaries layer only displays when you have zoomed out to the country level.

Steps:
1. Click the Show map contents icon to display the Contents pane.
2. On the Contents pane, click the arrow to the right of the layer for which you want to set the visible range.
3. Click Visible range to display the visible range settings.
4. Move the Minimum and Maximum sliders as desired.
5. Click OK.
   As you zoom in and out on the map, the layer displays only within the visible range you specified.

Set layer transparency

You can configure the transparency of each layer in the map. This allows you to see more or less of certain layers so that you can emphasize specific data. Transparency can be configured for all layers, excluding the basemap, regardless of the layer’s data source.

Steps:
1. Click the Show map contents icon to display the Contents pane.
2. On the Contents pane, click the arrow to the right of the layer whose transparency you want to set.
3. Drag the Transparency slider to the desired setting. A layer with 0 percent transparency has no transparency applied. A layer with 100 percent transparency is not visible in the map.
   Tip: You can also set the transparency by typing a value in the box beside the slider.
Change the basemap

A basemap provides a background, or visual context, for the data in a map. For example, a basemap showing streets can provide context for your address data. ArcGIS includes several different types of basemaps for you to use in Esri Maps for Dynamics CRM, including aerial imagery, terrain, streets, and topographic data. The default basemap displayed in the map is determined by your administrator. You can change the basemap at any time to one of the other maps provided.

Steps:

1. Click the Change basemap icon at the top of the map to display the basemap gallery.

2. In the gallery, click the desired basemap to select it.
   The map automatically displays the new basemap.
Use the map chart

Access map charts

Microsoft Dynamics CRM adds a Chart Pane to data grids. The chart pane is located to the right of the data grid and is collapsed by default. Follow these steps to access a map chart located in a chart pane.

Steps:

1. In the site map, click Workplace, Sales, Service, or Marketing and select one of the entity types supported by Esri Maps. Supported entity types are Accounts, Contacts, Leads, or Competitors.

2. To the right of the data grid, click Click here to view the chart to expand the chart pane.

3. Select one of the available charts by using the drop-down list at the top of the chart pane.

The layout of the chart pane can be modified to be across the top of the data grid by following these steps.

1. On the ribbon, click the Charts tab.

2. In the Layouts section, select the Chart Pane drop-down list and click Top.
Navigate the map

There are several options for navigating the map, including navigating with the mouse and using the zoom tools. You can use the mouse to pan (move), zoom in, and zoom out. The zoom tools can also be used to zoom in and out.

Navigate with the mouse

To begin exploring with your mouse, move the mouse pointer so that it is in the middle of the map display. Use the following table as a guide for completing navigation actions with the mouse.

Using the mouse to navigate offers the most flexibility. You can zoom to a specific area by pressing the Shift key and holding the mouse button while dragging a rectangle on the map. There is no equivalent to this using the zoom tools.

<table>
<thead>
<tr>
<th>Action</th>
<th>Mouse button</th>
<th>Mouse function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move or pan the map</td>
<td>Click the left mouse button and drag the map in the direction in which you want it to move.</td>
<td></td>
</tr>
<tr>
<td>Zoom in to a specific area on the map</td>
<td>Hold down the Shift key, then click and drag a rectangle with the left mouse button that designates the area of interest.</td>
<td>Note: You can also use the mouse scroll wheel to zoom in and out. Rotate the wheel up to zoom in and rotate down to zoom out.</td>
</tr>
<tr>
<td>Zoom out to a specific area on the map</td>
<td>Hold down the Shift and Ctrl keys, then click and drag a rectangle with the left mouse button that designates the area of interest.</td>
<td></td>
</tr>
<tr>
<td>Zoom in on the map at the location of the mouse pointer</td>
<td>Double-click the left mouse button on the point of interest.</td>
<td></td>
</tr>
</tbody>
</table>

Zoom in and out using the zoom tools

The zoom in (+) and zoom out (-) tools are shown at the top-right corner of the map and allow you to easily zoom in and out.

To use the zoom tools:

- Click the + (plus sign) button to zoom in.
- Click the - (minus sign) button to zoom out.
Zoom to the full extent of a layer

You can easily zoom the map to display all the features of a layer.

Steps:

1. Click the **Show map contents** icon to display the **Contents** pane.
2. Select the layer on the **Contents** pane.
3. Click the **Go to layer** icon at the bottom of the **Contents** pane.

   The map automatically zooms to display all the features in the layer.
View layer details

For layers that you have added from ArcGIS or layers you have shared on ArcGIS, you can access information about the item on ArcGIS. The information associated with the layer may include a description, access use and constraints, tags, credits, size, and extent.

Steps:
1. the Show map contents icon to display the Contents pane.
2. On the Contents pane, select the desired layer.
3. the Layer details icon at the bottom of the Contents pane.

If the Layer details icon isn't enabled, the selected layer does not have information accessible from ArcGIS.

The ArcGIS details page for the layer opens in your default web browser. If you are viewing the details for a layer that is not shared publically, you are prompted to log in to ArcGIS.
View layer attributes

You can easily get detailed geographic information about a feature layer in your map by viewing the layer’s attribute table. An attribute table includes information about each geographic feature in the layer—for example, an attribute table for a layer containing retail locations might include the name of the retail location, retail category, last year’s revenue and profit, and the address and postal code, for each retail location in the layer.

⚠️ **Note:** Viewing layer attributes is only available for feature layers.

**Steps:**

1. Click the **Show map contents** icon to display the **Contents** pane.
2. On the **Contents** pane, click the arrow to the right of the layer whose attributes you want to view.
3. Click **View selected records** to display an attribute table.
4. Click the **View** drop-down arrow and select **All**.

Attribute information for all of the geographic features in the layer are displayed in the attribute table. You can review the table, select features in the map by checking the check boxes beside corresponding records in the table, or zoom to any feature in a map by clicking in the table.

⚠️ **Note:** Depending on the number of features in your layer, you may need to use the page scroll buttons below the attribute table to see additional records.
Select features on the map

Selecting features on a map provides a way to identify, locate, and visually analyze a set or subset of data on the map. Once you have made a selection on the map, you can find features that are near your selection, view detailed information about the selected features in an attribute table, deselect certain features, or clear all selections.

Steps:

1. Click the Tools menu and click Select.
   
   **Note:** Depending on the size of the map, the Select pane may be displayed differently. Maps smaller than 450 pixels wide will display a compact pane that contains only the layer drop-down menu and the selection tools. From this pane, click More to display the full Select pane.

2. If necessary, drag your mouse on the map to move it to the desired location for making selections. You can also use the zoom tools to zoom in or out as needed.

3. Click the Choose a layer drop-down arrow and select the layer containing the features you want to select.

4. Do any of the following to make selections:
   
   **Note:** For point features, only features that are completely within the selection area are included in the selection.
   
   • Click the Rectangle selection tool and drag a rectangle on the map to select the features you want. To complete the selection, release the mouse.
   
   • Click the Free-hand selection tool and drag to draw a freehand shape on the map to select the features you want. To complete the selection, release the mouse.

   This step can be repeated multiple times to add features to the selection.

   **Note:** If your map has point features that have been clustered, you will not be able to select the clustered features on the map. You can turn off clustering to select the individual point features.

5. To clear all selections or remove part of your selection, do one of the following:
   
   • Click the Remove from selection tool and drag a rectangle around the features you want to remove from the selection.
   
   • Click the Clear selection tool to clear all selections in the layer.

   **Note:** If you are using the compact Select pane, click More to view all available selection options.

6. To find features in other layers in your map that are near your selection, click Find nearby and do the following:
   
   a. Click the What do you want to find drop-down arrow and select a layer.
   
   b. Click Ring to search within a specified distance around the selection, or click Drive time to search within a specified drive time of the selection.
   
   c. If you chose Ring, specify a radius in either miles or kilometers. If you chose Drive time, specify the maximum drive time from the selection in minutes or hours.
   
   d. Click Find.

   If you chose Ring, Esri Maps for Dynamics CRM generates a new temporary layer containing the circles that define the search radius. The features encompassed within that radius are selected on the specified layer.

   If you chose Drive time, Esri Maps for Dynamics CRM generates a new temporary layer containing the polygons that define the search area. The features encompassed within those polygons are selected on the specified layer.

   The search area for each Find nearby action is generated as a temporary layer in the Contents pane, using the name of the original layer with a prefix indicating the name of the related action; for example, Find nearby buffer - LayerName. You can use these layers as reference for future select actions.

   **Note:** These layers are temporary and are not saved with the map.

7. To view detailed attribute information about the features you selected, click View selected records on the Select pane. Attribute information for the selected features appears in an attribute table.
Tip: You can select additional features from this table to add to your selection. Click the View drop-down arrow and select All. Check the boxes for the records corresponding to the additional features you want to add to the selection. The features are selected on the map.

Tip: You can use the attribute table to zoom to a specific feature in the map.

8. Click Get route if your selected point features are destinations and you want to find the best driving route to reach them.
Zoom to a feature

You can easily get detailed geographic information about a feature layer in your map by viewing the layer's attribute table. An attribute table includes information about each geographic feature in the layer. You can zoom to a feature in your map by clicking the corresponding record in the attribute table.

**Note:** Zooming to features is only available for feature service layers.

**Steps:**

1. Select a feature on the map.
2. Under **What do you want to do with your selection?**, click **View selected records**. Attribute information for the selected features appears in an attribute table.
3. In the attribute table, find the record corresponding to the feature to which you want the map to zoom.
4. Click the icon in the **Go to** column for the record. The map zooms to the feature and the feature flashes briefly.

**Tip:** If pop-up windows are turned on for a layer, you can easily zoom to a feature in the layer by clicking the feature on the map and clicking the **Zoom to** icon on the pop-up window.
Delete a map chart

Map charts are deleted using the standard Microsoft Dynamics CRM delete chart functionality.

Note: Delete Chart will be disabled if you are not the owner of the map chart or do not have sufficient privileges.

1. Open Microsoft Dynamics CRM and browse to the entity (Account, Contacts, Leads, or Competitors) that contains the map chart you want to delete.
2. Display the map chart you want deleted in the chart pane.
3. Click the Charts tab on the ribbon and click Delete Chart.

Note: Alternately, you may delete a map chart from the Map Gallery. In the navigation pane, click on Esri Maps and select Map Gallery. Hover over the map chart you would like to delete and click the X in the upper right corner of the button. Select Yes to confirm deletion of the map chart.
Use Esri Maps in a dashboard

Dashboards act as a business intelligence tool in Microsoft Dynamics CRM by providing various visualizations of your data. You can use a dashboard to simultaneously present data from charts, grids, IFrames, and web resources. A dashboard acts as a container for these objects and can simultaneously present data from up to six visualizations, grids, IFrames, or web resources.

An Esri map chart can be added and configured in a dashboard by a user who has been assigned the Esri Maps User security role.

Add a new dashboard

1. Dashboards can be viewed by clicking Workplace, expanding My Work, and clicking Dashboards.
2. To create a new dashboard, click the New button on the ribbon and choose the layout you want to use.
3. Click Create to edit the new dashboard.
4. Name the dashboard in the Name field.
5. Click an empty panel and insert a chart, list, web resource, or IFrames from the ribbon. To add a map chart, click Chart, and choose the Record Type, View, and map Chart you want to use. Click Ok to finish configuring the panel.
6. Continue configuring dashboard panels until you are satisfied. Click Save and Close to view the completed dashboard.

Enlarge the chart

A visualization on a dashboard can be made larger by clicking Enlarge the chart in the upper right corner of the map chart.
Share a map on ArcGIS

Sharing a map created in Esri Maps for Dynamics CRM to ArcGIS is a quick and easy way to share information with others in or outside of your organization. When you share a map, a web map is created on ArcGIS, where you can do more work on it.

**Note:** You can only share a map to ArcGIS if you are signed in with an organizational account that has publisher permissions. If you are unsure of your account permissions, contact your ArcGIS subscription administrator.

Steps:

1. Sign in to ArcGIS if you are not already signed in.
2. Click the **Tools** menu and click **Share map**.
3. Specify a title, tags, and description for the map and choose whether to share it with everyone (public), your organization, or any groups to which you belong. These fields are used to display information about the map on ArcGIS, and are also used for searching.
4. Click **Share** to share the map to ArcGIS as a web map. Note that publishing may take several minutes depending on the amount of data in your map.
   Once the map has published successfully, a message appears at the bottom of the **Contents** pane along with a link to view the shared map on ArcGIS.
   **Note:** You can update the map and republish it to ArcGIS by clicking **Update shared map** under the **Tools** menu and modifying the information you entered as needed.
5. Click the link at the bottom of the **Contents** pane to view the published map. The web map details page opens in ArcGIS. The details page displays the title, tags, and description that you entered previously.

   6. Click **Open** to open the map in the ArcGIS.com map viewer, ArcGIS Explorer Online, or, if installed, ArcGIS for Desktop.
Perform analysis

Configure clustering

When a layer contains a large number of point features, showing each feature individually on the map is often not useful. In this scenario, point features often overlap, making it difficult to distinguish between features. Even when they do not overlap, it is usually difficult or impossible to visually extract meaningful information when hundreds or thousands of points are shown all at once.

One approach to resolving this issue is to group point features within a certain distance of one another on screen into one symbol. This is known as clustering. Since the clustering is dependent on screen distance, more points are aggregated into fewer groups as you zoom out. Conversely, points are divided into more and more groups as you zoom in. When you zoom to a level where the clustering area around one point feature no longer contains any other features, that feature will not be clustered but rather will be shown in its location with the styling specified by the layer.

Clusters are interactive: when you click on a cluster, each individual point feature in the cluster appears on the map. The cluster's pop-up window contains a separate page for each feature; use the forward and back arrows in the pop-window's title bar to scroll through pop-ups for each feature. Although you cannot change the default style of a single cluster, you can change the basic color that applies to all clusters, and the color of the text that appears within a cluster. In the screen captures below, the image on the left displays the points with clustering enabled, and the image on the right does not have clustering enabled.

If you styled a point layer using shapes grouped by category, the clusters will display a pie chart showing the ratio of different categories within that cluster. As you zoom in, the cluster is divided into smaller groups and the pie chart changes to reflect the information in the new cluster.

Steps:

1. Click the Show map contents icon to display the Contents pane.
2. On the Contents pane, click the arrow to the right of the point layer for which you want to configure clustering.
3. Click the On/Off selector next to Clustering to turn on clustering for the layer.
   The map automatically displays the default clustering symbols for the layer, and the Configure clustering icon appears beside the On/Off selector.
   
   Note: To turn off clustering, click the On/Off selector again.
4. Click the Configure clustering icon.
5. Do any of the following to configure clustering for the layer:
   • To change the distance at which points will be grouped together in a cluster, enter a new pixel value in the Cluster radius box.
   • To change the color of the text on the cluster symbols, click the Text color drop-down menu and select a new color.
   • To change the color of the cluster symbol, click the Cluster color drop-down menu and select a new color.
The map automatically updates to reflect the new cluster settings.

6. Click **OK** when you are finished.
About finding a route

It is often necessary to analyze your data to answer questions such as:

- What is the quickest way to get from point A to point B?
- How can a fleet of delivery or service vehicles improve customer service and minimize transportation costs?
- Which branch of a store should a potential customer visit to minimize travel time?

Esri Maps for Dynamics CRM can help you find the best way to get from one location to another or visit multiple locations. The best route is the shortest route that minimizes the travel time. If you have more than two stops to visit, Esri Maps for Dynamics CRM can determine the best sequence in which to visit the locations. This is called route optimization.

Esri Maps for Dynamics CRM uses specialized services from ArcGIS—the route service and the world geocoding service—to find an optimal driving route. To do this type of analysis, your map must have at least one feature layer containing points. This data can come from ArcGIS or from Microsoft Dynamics CRM.

**Note:** The route service and the world geocoding service work in all supported countries. One or more countries are grouped together to form a region. The route service does not support requests that span more than one region. Consequently, a route will be found only between those stops that are in the same region as the first stop.
You can easily find a driving route by specifying two or more destinations in your point layer. Once Esri Maps for Dynamics CRM finds the best route using the destinations you specified, you can zoom to the full route or print out driving directions.
Find a driving route

With Esri Maps for Dynamics CRM, you can easily find a driving route by specifying two or more destinations in your point layer using any of the following methods:

- Selecting destinations on your map using a selection tool
- Specifying a destination by adding a pin
- Manually entering addresses

When Esri Maps for Dynamics CRM finds the best route using the destinations you specified, you can zoom to the full route or print out driving directions.

Steps:

1. Click the Tools menu and click Get route.
2. Specify the destinations you want to include in your route using any of the following methods:
   - Click the Select tool and click and drag a rectangle on the map to select the points you want to use as destinations. Your map must contain points to select.
   - Click the Drop pin tool and click a point on the map to add it as a destination. The destination is added as the first stop.
   - Click the Enter an address tool and type an address in the empty destination box.
   You can repeat any of these methods until all destinations have been specified.
3. Do any of the following to make changes to your destinations:
   - To remove a destination from the route, click the small x beside the destination. This is only available if there are more than two destinations. The x icon appears only when your route contains more than two destination points. When the route consists of only two points, the Reverse directions icon appears beside the addresses.
   - To switch the start and end destinations, click the Reverse directions icon to the right of the destination list.
   - To rearrange three or more destinations, hover the pointer over the letter icon (A, B, C) until the icon changes to a four-directional arrow. Click and drag the destination field to the desired location in the list of destinations.
   - To change the location of a stop on the map, click the icon on the map and drag it to a new destination; the new address is updated in the address field.
     ✋ **Note:** You can move destination points on the map after generating the original route; click Get route again to update the driving route after you move a destination point.
   - If you want Esri Maps for Dynamics CRM to determine the best sequence in which to visit four or more specified destinations, check the Optimize order check box. When optimizing a route, the first and last stops are fixed and the intermediate stops are optimized.
4. When you are finished specifying destinations for your route, click Get route.

The route is displayed on the map. Information about the route, including route length (miles or kilometers) and estimated driving time, appears under the list of destinations.

💡 **Tip:** To see the entire route displayed in the map, click Zoom to full route.

5. To view and print driving directions for the route, click the Print icon, and then click Print on the directions page that appears. Modify the print settings as needed and click Print.
   The resulting printout consists of a map that contains the route and the stops.
6. To clear the route, close the Get route pane.
Infographics

Infographics are visualizations that provide rich contextual information about the areas surrounding the features in your map. When you click the **Infographics** icon in a pop-up window, ArcGIS aggregates the demographics around that feature on your map and delivers them using easy-to-understand Infographics that contain information such as age distribution and income for a set distance around the selected location. The information contained in Infographics is available while the pop-up window is open and is not saved to your business system.
In the image below, an Infographic shows the age distribution within a one-mile radius of a university hospital. As expected, the bars show a much higher percentage of men and women between the ages of 20 and 24 in the university neighborhood. Some Infographics may contain comparisons for different demographics; if so, click the arrow in the pop-up window's title bar to view different feature representations.

**Note:** The Age Pyramid Infographic displays two variables: male population and female population. The blue bars representing male population add up to 100 percent and the pink bars representing female population also add up to 100 percent. Adding the percentage values for pink bars and blue bars together would be incorrect.
To view a more detailed Infographic, click the **Maximize** button in the pop-up window's title bar. Click **Restore** to return the window to its original size.

Many Infographics are interactive; hover over elements in the Infographics or use the **Forward** and **Back** arrows to display additional information.

Click the **Previous** and **Next** arrows on the Infographics window to scroll through available feature visualizations.
Add a heat map

When a layer contains a large number of point features, showing each feature individually on the map is often not useful. In this scenario, point features often overlap, making it difficult to distinguish between features. Even when they do not overlap, it is usually difficult or impossible to visually extract meaningful information when hundreds or thousands of points are shown all at once.

One approach to resolving this issue is to create a heat map. A heat map represents the geographic density of point features on a map by using colored areas to represent those points. The areas will be largest where the most points are concentrated together.

Note: Heat map layers and layers that are clustered cannot be shared to ArcGIS as a layer, but can be shared as part of a map. In the ArcGIS.com Map Viewer, the heat map layer displays as a point layer instead of rendering as a heat map.

Steps:

1. Enter map chart design mode by choosing Esri Maps in the navigation pane, selecting Map Gallery, and on the map chart to which you would like to add a heat map.
   
   Note: A heat map can only be added to a map by editing it in the Map Gallery.

2. the Show map contents icon to display the Contents pane.

3. On the Contents pane, the arrow to the right of the point layer for which you want to configure a heat map.

4. Add heat map to create a heat map of your layer.
   
   Note: The Heat map item will be disabled if Clustering is turned on. You must first turn off clustering before applying and configuring a heat map.

A new heat map layer appears in the Contents pane. The map automatically displays the heat map under the original points layer.

Note: To turn off the heat map, check the check box beside the heat map layer in the Contents pane.
5. To change the way the heat map appears on the map, from the Contents pane, the arrow to the right of the heat map layer and Configure heat map.

6. Do any of the following to configure the heat map:
   • Select a color scheme from the Color scheme menu.
   • Adjust the intensity of the heat map using the Intensity slider.

   The map automatically updates to reflect the new heat map settings.

7. OK when you are finished.

   Note: You can also set the visible range and the transparency of the heat map layer, if desired.
Create reports

Reports can be created for a location or point on the map and saved in PDF or Excel formats. Reports can be generated to include values for a distance of rings or drive distance or within a drive time. There are 20 different reports that provide information about the area of your choice. Reports include Demographic and Income Profile, Executive Summary and Retail Goods and Services Expenditures. These reports can be used to describe and gain a better understanding about the market, customers/clients and competition associated with your area of interest. Once created, reports can be shared and sent to others.
You can create reports for a feature on the map. Features can be rivers, roads, pipelines, buildings, counties, political subdivisions as well as points, lines and polygons. Any data that you add is also added as a feature on the map.

Steps:

1. Click on a feature on the map to display the pop-up to access reports.

![Feature on Map]

2. Click the Create report icon. The dialog box appears where you can set the parameters for the report you want to create.

![Create Report Dialog]

3. Click the Select report drop-down arrow to select the report you want to run.

4. Click the Format drop-down arrow to select the format for your report. You can choose from PDF or Excel.

5. Click the Show data for drop-down arrow for rings, drive times and drive distance.

6. Select the radius and units for your report.

7. Click Create report. The report icon appears at the bottom of the page. Click on it to open.
Reference

Frequently asked questions

Does Esri Maps for Dynamics CRM require an ArcGIS Online subscription?
Yes. An ArcGIS Online for Organizations subscription is required. Esri Maps for Dynamics CRM can also connect to Portal for ArcGIS.

Does Esri Maps for Dynamics CRM consume credits?
Yes, for geocoding, enrichment, infographics, and other services.

Is Esri Maps for Dynamics CRM available with Portal for ArcGIS?
Yes!

Does Dynamics CRM data get passed to ArcGIS Online?
Only address-related field values and the entity ID (GUID) are passed to ArcGIS Online services to perform geocoding and geoenrichment. Geocoding can occur during mapping if coordinates are not already present and/or when using the place lookup style of geocoding.

Can organizations consume layers and maps from their own ArcGIS Server?
Yes. If their services on ArcGIS Server are public facing, they can be accessed through ArcGIS Online as web maps, map services, and so on. If their data or services are internal, they can consume layers, web maps, and custom geocode services configured with their ArcGIS portal/online organization. Currently, they cannot access other ArcGIS Server services that are not available through ArcGIS Online or Portal for ArcGIS.

Does Esri Maps for Dynamics CRM work on the iPad?
Yes, at v1.0, as of July 2013. It works on iPad via the dashboard and entity view map chart. Designer and sign-in experiences are unavailable in Safari due to technical limitations.

Why is the 'create report' link not working in pop-ups?
Certain versions of Internet Explorer (IE) will cause an error page to appear when you click on 'create report' link within a pop-up. The problem is limited to IE 9 and earlier versions of IE10. The latest version of IE10 does not seem to experience the problem. There are a few possible fixes:

• Upgrade Internet Explorer to the latest version.

• Add geoenrich.arcgis.com to the local intranet zone within Internet Explorer settings. Go to Internet Options > Security. Click the 'local intranet' icon and then click the 'sites' button. Click the 'advanced' button in the window that appears. Enter geoenrich.arcgis.com and click 'add.' Close the remaining windows.

• Allow IE to save encrypted content to disk. Go to Internet Options > Advanced. Uncheck the box next to 'Do not save encrypted pages to disk.'
Essential vocabulary

Basemap
A basemap provides a geographical context, or background, for the content you want to display in a map. With Esri Maps for Dynamics CRM, you can choose from several Esri basemaps hosted on ArcGIS. These basemaps include many options that combine road, aerial, and topographic data with a variety of symbology. If your organization makes them available, you can also access basemaps in your ArcGIS Organization.

Clustering
Clustering in Esri Maps for Dynamics CRM refers to grouping point features within a certain distance of each other into one symbol. This is different from grouping in Esri Maps for Dynamics CRM where features are grouped by a user-specified category and styled accordingly.

Contents pane
The Contents pane is a central component of Esri Maps for Dynamics CRM. The Contents pane displays the list of layers contained in the map, provides the ability to toggle layer visibility, and provides a starting point for setting layer properties such as styling, heat maps, transparency, visible range, clustering, and pop-ups.

Coordinate system
Coordinate systems provide a framework for defining real-world locations. In Esri Maps for Dynamics CRM, there are two supported coordinate systems: World Geodetic Survey 1984 (WGS84) and Web Mercator. WGS84 is a geographic coordinate system in which every location on the earth is specified by a set of numbers (coordinates). Coordinates are often expressed as latitude and longitude values. Web Mercator is a projected coordinate system in which locations are identified by x,y coordinates on a grid, with the origin at the center of the grid. Coordinate values in the Web Mercator system generally have 6, 7, or 8 digits to the left of the decimal, and the units are meters. If you are unsure as to which coordinate system you should use, please contact the originator of your data or the person who collected it.

Coordinates
A set of values represented by the letters x and y that define a position within a spatial reference. Coordinates are used to represent locations in space relative to other locations. Coordinates are often shown in latitude-longitude pairs, where x coordinates range from -180 to 180 and y coordinates range from -90 to 90, or as values with 6, 7, or 8 digits to the left of the decimal point. When using Esri Maps for Dynamics CRM, these value pairs are often composed of the values from two columns in your data.

Feature
Geographic features are representations of things located on or near the surface of the earth. Geographic features can occur naturally (such as rivers and vegetation), can be constructions (such as roads, pipelines, wells, and buildings), and can be subdivisions of land (such as counties, political divisions, and land parcels). Geographic features are most commonly represented as points, lines, or polygons. In Esri Maps for Dynamics CRM, data you have added is often referred to as features on the map.

Grouping
Grouping in Esri Maps for Dynamics CRM is the process of placing features in user-specified categories and styling them accordingly.

Heat map
A heat map represents the geographic density of point features on a map by using colored areas to represent those points. The areas are largest where the most points are concentrated together.

Layer
A layer is the way in which Esri Maps for Dynamics CRM visually represents geographic datasets. A layer can be thought of as similar to a legend item on a paper map. On a road map, for example, roads, national parks, political boundaries, and rivers might be considered different layers. When you add Microsoft Dynamics CRM business data to a map, Esri Maps for Dynamics CRM creates a
layer and displays it on the Contents pane. Once the layer is created, functionality such as determining visibility, configuring style, and setting transparency are all enabled.

Lines
Lines represent the shape and location of geographic objects too narrow to depict as areas (such as street centerlines and streams).

Map
A map displays geographic data and allows you to explore and interact with that data. In Esri Maps for Dynamics CRM, you can add Microsoft Dynamics CRM data directly to the map and combine it with additional content from ArcGIS Online.

Pan (the map display)
Shift a map image relative to the display window without changing the viewing scale. Panning a map can also be thought of as moving the map image in the display window so that you can see different parts of the map. Panning is done with a click and drag mouse action on the map image.

Points
Points represent discrete locations of geographic features too small to be depicted as lines or areas, such as well locations, telephone poles, and stream gauges. Points can also represent address locations, Global Positioning System (GPS) coordinates, or mountain peaks.

Polygons
Polygons are enclosed areas (many-sided figures) that represent the shape and location of homogeneous features such as states, counties, parcels, and land-use zones.
Copyright information

Copyright(C) 1995-2013 Esri
All rights reserved

The information contained in this document is the exclusive property of Esri and its licensor(s). This work is protected under United States copyright law and other international copyright treaties and conventions. No part of this work may be reproduced or transmitted in any form or by any means, electronic or mechanical, including photocopying and recording, or by any information storage or retrieval system, except as expressly permitted in writing by Esri. All requests should be sent to Attention: Contracts and Legal Services Manager, Esri, 380 New York Street, Redlands, CA 92373-8100, USA

The information contained in this document is subject to change without notice.

U.S. Government Restricted/Limited Rights

Any software, documentation, and/or data delivered hereunder is subject to the terms of the License Agreement. The commercial license rights in the License Agreement strictly govern Licensee's use, reproduction, or disclosure of the software, data, and documentation. In no event shall the U.S. Government acquire greater than RESTRICTED/LIMITED RIGHTS. At a minimum, use, duplication, or disclosure by the U.S. Government is subject to restrictions as set forth in FAR §52.227-14 Alternates I, II, and III (DEC 2007); FAR §52.227-19(b) (DEC 2007) and/or FAR §12.211/12.212 (Commercial Technical Data/Computer Software); and DFARS §252.227-7015 (NOV 1995) (Technical Data) and/or DFARS §227.7202 (Computer Software), as applicable. Contractor/Manufacturer is Esri, 380 New York Street, Redlands, CA 92373-8100 USA.

Esri Trademarks

@esri.com, 3D Analyst, ACORN, Address Coder, ADF, AML, ArcAtlas, ArcCAD, ArcCatalog, ArcCOGO, ArcData, ArcDoc, ArcEdit, ArcEditor, ArcEurope, ArcExplorer, ArcExpress, ArcGIS, ArcGlobe, ArcGrid, ArcIMS, ARC/INFO, ArcInfo, ArcInfo Librarian, ArcInfo—Professional GIS, ArcInfo—The World’s GIS, ArcLessons, ArcLocation, ArcLogistics, ArcMap, ArcNetwork, ArcNews, ArcObjects, ArcOpen, ArcPad, ArcPlot, ArcPress, ArcQuest, ArcReader, ArcScan, ArcScene, ArcSchool, ArcScripts, ArcSDE, ArcSdl, ArcSketch, ArcStorm, ArcSurvey, ArcTIN, ArcToolbox, ArcTools, ArcUSA, ArcUser, ArcView, ArcVoyager, ArcWatch, ArcWeb, ArcWorld, ArcXML, Atlas GIS, AtlasWare, Avenue, BAQ, Business Analyst, Business Analyst Online, BusinessMAP, CommunityInfo, Data Automation Kit, Database Integrator, DBI Kit, EDN, Esri, Esri—Team GIS, Esri—The GIS Company, Esri—The GIS People, Esri—The GIS Software Leader, FormEdit, GeoCollector, Geographic Design System, Geography Matters, Geography Network, GIS by Esri, GIS Day, GIS for Everyone, GISData Server, JTX, MapBeans, MapCafé, MapData, MapIt, Maplex, MapObjects, ModelBuilder, MOLE, MPS—Atlas, NetEngine, PC ARC/INFO, PC ARCPLT, PC ARCSHELL, PC DATA CONVERSION, PC STARTER KIT, PC TABLES, PC ARCEDIT, PC NETWORK, PC OVERLAY, PLTS, Rent-a-Tech, RouteMAP, SDE, Site-Reporter, SML, Sourcebook•America, Spatial Database Engine, StreetEditor, StreetMap, Tapestry, the ARC/INFO logo, the ArcAtlas logo, the ArcCAD logo, the ArcCAD WorkBench logo, the ArcCOGO logo, the ArcData logo, the ArcData Online logo, the ArcEdit logo, the ArcEurope logo, the ArcExplorer logo, the ArcGIS logo, the ArcGIS Explorer logo, the ArcGrid logo, the ArcIMS logo, the ArcInfo logo, the ArcLogistics Route logo, the ArcNetwork logo, the ArcPad logo, the ArcPlot logo, the ArcPress for ArcView logo, the ArcPress logo, the ArcScan logo, the ArcScene logo, the ArcSDE CAD Client logo, the ArcSDE logo, the ArcStorm logo, the ArcTIN logo, the ArcTools logo, the ArcUSA logo, the ArcView 3D Analyst logo, the ArcView Data Publisher logo, the ArcView GIS logo, the ArcView Image Analysis logo, the ArcView Internet Map Server logo, the ArcView logo, the ArcView Network Analyst logo, the ArcView Spatial Analyst logo, the ArcView StreetMap 2000 logo, the ArcView StreetMap logo, the ArcView Tracking Analyst logo, the ArcWorld logo, the Atlas GIS logo, the Avenue logo, the BusinessMAP logo, the Data Automation Kit logo, the Digital Chart of the World logo, the Esri Data logo, the Esri globe logo, the Esri Press logo, the Geography Network logo, the GIS Day logo, the MapCafé logo, the MapObjects Internet Map Server logo, the MapObjects logo, the MOLE logo, the NetEngine logo, the PC ARC/INFO logo, the Production Line Tool Set logo, the RouteMAP IMS logo, the RouteMAP logo, the SDE logo, The Geographic Advantage, The Geographic Approach, The World’s Leading Desktop GIS, Water Writes, www.esri.com, www.geographynetwork.com, www.gis.com, www.gisday.com, and Your Personal Geographic Information System are trademarks, registered trademarks, or service marks of Esri in the United States, the European Community, or certain other jurisdictions.

Other companies and products mentioned herein may be trademarks or registered trademarks of their respective trademark owners.